Лики Белого Носорога.

 На Вашем диске поселился новый, пока что мало понятный зверь по имени

                              Rhinoceros 3…..

 Открыв рабочий, стол по началу испытываешь разочарование. Ну, как же!

Нет, привычных для пользователей ACAD и 3DMax, навороченных меню.

 Набор инструментов, кажется бедноватым и каким то не серьезным.

Ну, что ж. Привыкшим к другим программам, зачастую трудно принять 

новое построение интерфейса. Программа, это инструмент. И как к инструменту

к ней привыкаешь и многое делаешь автоматом, не задумываясь над деталями.

  Однако посмотрим, все же, что умеет этот зверь.

Рабочий стол Носороговеда.

Вот скрин рабочего стола программы.
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Начальные сведения по управлению.

 Особенность программы – легкий переход по окнам.

 Вложенные меню. Они обозначены треугольниками в правом нижнем углу иконки.

Вызываются затянутым щелчком левой кнопки мыши. 

 На верху видна белая полоса командной строки. При желании можно набирать команду там. Но кроме этого она несет еще одну нагрузку. При вызове команды в ней появляются

настройки самой команды. Это то, что в скобках. Подчеркнутые буквы – горячие клавиши. Можно просто кликнуть на нужном слове мышкой.

Еще одна особенность – использование фонового рисунка отдельного для каждого окна.

 Об этом подробнее позже.

Окно перспективы отличается от остальных тем, что при нажатой правой клавише мыши

картинка вращается. В остальных же окнах это режим панорамы.

 Если же при нажатой правой еще удерживать “Ctrl”, в окне перспективы тоже включается

режим панорамы.

 В нижней части стола расположены: 

координатное окно, индикатор – переключатель

слоев, Индикаторы – переключатели режимов “Snap”(Шаг), “Ortho”(Ортогональная привязка), “Planar” и  “Osnap”.

 При включенном режиме “Osnap”, появиться меню привязок. Он чуть выше.

Кнопка “Disable” отключит действие привязки в любой момент. 

“Project” заставит строить объекты только на плоскости окна, не зависимо от того, включена привязка или нет. При этом включенная привязка будет действовать как

положено. Иногда это очень помогает.

 Все настройки режимов и цветов расположены в меню File > Properties или Tools > Options. 

 Что бы описание работы было более наглядным, зададимся целью создать 

реальный проект. Поскольку  лодки  мне ближе по интересам и что бы совместить 

реальную работу с описанием, возьму как пример  разработку швербота.

  Сразу оговорюсь – вариантов исполнения объекта или операции может быть много.

Каждый выбирает те, которые ему удобнее. 

Начало. 

 Итак, зададим параметры, которые нас устроят.

Это будет легкий швербот, длиной 4,7 м.

 Для начала сделаем эскиз, который будет состоять из кривых образующих корпус.

Настроим рабочий стол.

 Убираем сетку. Она не нужна. Для этого щелкаем правой кнопкой на названии окна.

В открывшемся меню выбираем “Greg Options”. В открывшемся окне свойств снимаем

флажки показа сетки, координатных осей и иконки координат. 

  Включаем режимы “Snap”, “Orto”, “Planar”, “Osnap”.

Можно рисовать.

 Команда “Line”. Или [image: image2.bmp]   >  [image: image3.bmp].  Ставим стартовую точку. Затем сдвинув курсор

вправо, на клавиатуре набираем “ 4700”. Жмем клавишу «Enter» и потом левую кнопку мыши. Получаем прямую длиной 4700 мм. Я подробно описал последовательность действий которая часто используется в работе. Дальше я просто буду писать – «задаем».

 Итак, имеем первый объект в Rhino.

По ходу замечания: Если нужно отменить начатую команду, надо нажать «Esc» или правую кнопку.

 Для того, чтобы увидеть все объекты в окне кликаем на [image: image4.bmp]. Тут опять не однозначно.

Если нажать левую кнопку, команды управления сработают в активном окне. 

Если же правую – во всех окнах.

 Дальше нужно создать ширину носовой оконечности и транца.

Пока на глаз создаем 2 вертикальные прямые и затем включив привязки “End” и “Mid”

(Конечная и средняя точки), командой “Move” переносим их поочередно к началу и концу

первой линии. При вызванной команде нужно щелкнуть левой кнопкой на выбираемом объекте. Он подсвечивается желтым цветом. Если объект нужен один и добавлять в набор ничего не надо, щелкаем правой. Теперь курсор меняет вид. Выбор закончен.

 Подводим его к середине отрезка. Появиться белая метка с названием точки привязки.

Когда она появилась, можно щелкать левой. Объект (или группа объектов) захвачен.

 Переводим курсор к началу прямой и щелкаем левой. Прямая встанет средней точкой

на начало прямой.  

 Использование привязок очень удобно тем, что гарантирует правильность размещения объектов. Для того, что бы избежать неточностей, лучше работать с включенным режимом привязки.

 Для повтора команды достаточно нажать правую кнопку.

 Естественно, в дальнейшем я не буду так подробно описывать все действия. Иначе сей труд рискует стать рекордсменом по объему и нудности. 

 Поехали дальше. Нам нужны контуры линии слома. Делаем их на виде с верху.

Двойным щелчком левой развернем окно. Так виднее.

Команда “Interp Crv”. Это  здесь -  [image: image5.bmp]  >  [image: image6.bmp]. Выключаем “Ortho” и строим кривую по 

трем точкам. 

 Так же создаем линию палубы, скулы и кильбалки. 

Особой точности не требуется. Достаточно приблизительно наметить их положение

и форму.

  Почему по трем? Для получения плавного сплайна не имеющего S образного изгиба

нужны три точки. Каждая новая точка увеличивает возможность потери плавности.
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Вы обратили внимание на то, что я довольно небрежно обозначил начало и конец

кривых. Сделано это намеренно и , как ни странно, для получения точных точек начала и конца. Для достижения этой благой цели выбираем  [image: image8.bmp], показываем отрезки по которым надо резать ( можно несколько ). Затем правая кнопка ( окончить выбор ) и показываем, что надо обрезать.
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Теперь мы имеем набор кривых из которых можно сваять контуры нашей лодки.

Но они все расположены на  одной плоскости, что нас не совсем устраивает.

  Выбираем кривые. Выбрать можно, обозначив зону выбора мышью.

Ставим курсор на первую точку зоны, правую верхнюю, жмем левую кнопку и тащим курсор вниз и влево, держа кнопку нажатой. Захватив прямоугольником нужные объекты,

отпускаем кнопку. Имеем набор объектов для работы с командой.

Опять не просто все. Если вести курсор влево, выбранными будут объекты хотя бы частично попавшие в зону. При движении вправо, только те, что попадают целиком.

Сбросить выбор можно “Esc” или просто щелкнув на пустом месте окна.

Теперь нажав “F10” включаем показ контрольных точек. Их появилось пять на каждой кривой. Удаляем по две лишние, выбрав их и нажав “Delete”.
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Выбирая точки, командой “Move”передвигаем их до получения нужного результата.

Выбрать несколько объектов можно или зоной или щелкнув на каждом поочередно, удерживая “Shift”.
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Обратите внимание на то, что при указании курсором на несколько объектов появляется окошко с набором этих объектов. Перебирая их в окне можно выбрать нужный. Он подсвечивается при выборе.

Добившись нужного результата, выключаем контрольные точки “F11”. Возможно, придется несколько раз повторить операцию, пока все не станет таким, как хочется.

 Для контроля размеров используем меню “Dimension”.

Иконка  [image: image12.bmp]  даст возможность настроить стиль размеров. Общий масштаб, шрифт,

количество знаков, расположение размерных текстов и вид размерных линий…
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Используя привязки проверяем интересующие размеры.

 Чтобы было удобнее, жмем [image: image14.bmp] и в окне переименовываем или создаем новый слой –

“Dim”. Ставим на нем флажок активного слоя и задаем слою красный цвет.

Теперь все объекты созданные нами будут жить на этом, активном, слое.
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Если же какой то из них попал туда по ошибке, можно вызвать  [image: image16.bmp] и изменить свойства

объекта.
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 Естественно, пошагово описывать муки творчества для получения нужных результатов я не стану. Предположим, что изображенное на следующей картинке всем нравится.
 Однако, увидеть это в линиях – одно. А вот в объеме может и не понравится.

В ходе работы можно использовать для проверки результата команду “ Loft “.

  Функция очень полезная, но и не простая. По тому, о ней подробнее.

Для того, что бы увидеть наш корпус, сделаем симметричные ДП кривые обводов.

 Выбрав нужные кривые включаем “ Mirror”(Зеркало). [image: image18.bmp] > [image: image19.bmp]. Показываем ось
симметрии. При включенном режиме “Ortho” достаточно показать первую точку и отвести

курсор в нужном направлении. 

  Углы, по которым будет привязываться «орто» режим, можно задать в File > Properties >

Modeling Aids. Нужно поставить значение углового шага в окошке  “Ortho Snap every”.

 Например, поставив 45.0, будем иметь привязку в 45 градусов.
 Сделав зеркальную копию наших кривых, приступаем к лофту. То есть к построению по ним поверхности.
 Обратите внимание на командную строку, при вызове зеркала. Команда может делать копию объектов, а может и просто зеркально перенести их, в зависимости от режима

работы.

 Нажав  - [image: image20.bmp] > [image: image21.bmp]. Включаем команду и строго по порядку указываем кривые по которым надо строить. При этом обязательно надо соблюдать порядок следования.

Кроме того, есть особенность. Если показать на концы кривых с разных сторон, получим

перекрученные поверхности.
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Первая поверхность получена по прямым 1-2 и 3-4. Порядок указания 1 – 3.

Вторая, по тем же прямым, но с порядком 1 – 4.
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 В открывшемся окне устанавливаем стиль “Straight sections”. Стиль влияет на построение поверхности. Работу остальных лучше посмотреть включив их и нажав “Preview”.

 Теперь мы видим, как наша лодка будет выглядеть в объеме. 

Однако, даже на предыдущем рисунке видно, что что то не так с картинкой.

 Поверхность ребристая и отстает от кривых. Это явление часто пугает пользователей, вызывая нарекания типа – глючит Носорог! Дырки делает.
 На самом деле все не так. Видимые поверхности это просто визуальное обозначение их.

Как бы фантом, что бы было видно, что там что то есть. К точности построения они никакого отношения не имеют. Если же это сильно давит, можно открыть File > Properies>
Mesh и установив флажок “Custom” задать “Maximum angle” скажем, в 5 градусов.

 Теперь картинка станет значительно красивее, но при перерисовке экрана она будет испытывать Ваше терпение. Время перерисовки значительно увеличится.

 Но, для наглядности, пока потерпим….
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 Как Вы помните, кривые, по которым строилась поверхность, имели 3 контрольных точки. Стало быть, сюрпризов с гладкостью поверхности не должно быть. Видно, что поверхности имеют по одной изолинии. Но для спокойствия и примера, поиздеваемся над 

нашим первым продуктом. 

 Вызовем свойства объекта и увеличим количество изолиний:
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 Уже можно посмотреть, что где не ровно. 

Но нам этого мало. Мы хотим убедится, что наша модель ровная и гладкая.

 Включаем Analyze > surface > Environment Map.  [image: image26.bmp] >[image: image27.bmp] >  [image: image28.bmp]
В результате, отключив показ изолиний, что б не мешали, любуемся отражением в нашей поверхности  пейзажа. Покрутив модель в окне перспективы, можно убедится, что на поверхности нет ям, бугров и переходы плавные.
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  Для более научного анализа, предлагается целый набор инструментов. С ними, я думаю придется разбираться отдельно. Как пример еще, анализ по Гауссу.
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 Меню анализа предлагает большой набор инструментов. Можно измерить площадь, дистанцию, координаты точек,  длину отрезка, плавность его, массу объекта, центры площади и массы…

 Ну и много чего еще.

Пока же ограничимся тем, что наша модель нам нравится!
 Убираем кривые, что б не мешали работать. Жмем  [image: image31.bmp] > [image: image32.bmp]. С выделившимися линиями
поступаем по желанию. Можно грубо нажав “Delete” отправить их в вечность. Можно скрыть их  [image: image33.bmp]. Тогда они не будут видны, и не будут участвовать в работе, но останутся в проекте. Щелкнув правой на той же кнопке, мы вернем их все на стол. Если нам нужны не все скрытые объекты, жмем - [image: image34.bmp] > [image: image35.bmp] и выбрав нужные правой кнопкой возврвщаем их на стол. 
 Кнопка    [image: image36.bmp]  >  [image: image37.bmp] позволит оставить объект на столе, но из работы его исключит.

Действие остальных кнопок попробуйте в работе. Ничего страшного они не сделают.

 Однако, если ситуация в ходе эксперементов вышла из под контроля, всегда можно нажав
Undo отменить предыдущие команды. Их количество можно задать в том же «Properties».

 Однако, размер файла подсказывает, что на создании первой поверхности стоит закончить первую часть. Я намеренно подробно описывал здесь операции, для того, что бы было легче освоиться со стилем работы Носорога. Добавлю еще, что приемы работы вырабатываются у каждого в ходе общения с программой. Описать подробно все ее функции сложновато. По ходу работы возникают задачи, порой нестандартные. В таких случаях я смотрю, может ли программа решить их, копаясь в наборе инструментов. Если нет, приходиться комбинациями команд добиваться нужного результата.

  Для корабелов.  Подход к проектированию корпуса судна несколько отличен от традиционного. Чаще рациональнее построить сначала модель корпуса, пользуясь приемами о которых позже, а по этой модели получить теоритический чертеж, как производное, и построить практические чертежи. Используя способность  Rhino
укладывать в каждое окно проекций отдельный растровый рисунок, можно построить модель по отсканированным рисункам.

Вставить в активное окно растровый рисунок -  [image: image38.bmp] > [image: image39.bmp] . Масштабом [image: image40.bmp] и смещением

[image: image41.bmp]  подгоняем рисунки на место и в трех проекциях строим модель подгоняя ее по рисункам.

